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Message from the Director General  

With the primary objective of realizing the National Educational Goals recommended by the 

National Education Commission, the then prevalent content based curriculum was modernized, and 

the first phase of the new competency based curriculum was introduced to the eight year curriculum 

cycle of the primary and secondary education in Sri Lanka in the year 2007  

The second phase of the curriculum cycle thus initiated was introduced to the education system in 

the year 2015 as a result of a curriculum rationalization process based on research findings and 

various proposals made by stake holders.  

Within this rationalization process the concepts of vertical and horizontal integration have been 

employed in order to build up competencies of students, from foundation level to higher levels, and 

to avoid repetition of subject content in various subjects respectively and furthermore, to develop a 

curriculum that is implementable and student friendly.  

The new Teachers’ Guides have been introduced with the aim of providing the teachers with 

necessary guidance for planning lessons, engaging students effectively in the learning teaching 

process, and to make Teachers’ Guides will help teachers to be more effective within the classroom. 

Further, the present Teachers’ Guides have given the necessary freedom for the teachers to select 

quality inputs and activities in order to improve student competencies. Since the Teachers’ Guides 

do not place greater emphasis on the subject content prescribed for the relevant grades, it is very 

much necessary to use these guides along with the text books compiled by the Educational 

Publications Department if, Guides are to be made more effective.  

The primary objective of this rationalized new curriculum, the new Teachers’ Guides, and the new 

prescribed texts is to transform the student population into a human resource replete with the skills 

and competencies required for the world of work, through embarking upon a pattern of education 

which is more student centered and activity based.  

I wish to make use of this opportunity to thank and express my appreciation to the members of the 

Council and the Academic Affairs Board of the NIE the resource persons who contributed to the 

compiling of these Teachers’ Guides and other parties for their dedication in this matter.  

 

Dr. (Mrs.) Jayanthi Gunasekara 

Director General  

National Institute of Education  
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Introduction 

 

Information and Communication Technology has been identified worldwide as a tool that can be 

used to improve productivity, efficiency and effectiveness of organizational work and the daily 

activities of individuals. Therefore, providing an adequate level of ICT knowledge and skills, at 

different levels of education, is important for the students to progress and contribute towards 

national development. 

 

The current Sri Lankan Secondary Education System has been substantially exposed to ICT through 

various programs including CAL, ICT for GCE (O/L), GIT at grade 12 and ICT as a component in 

A/L Technology stream. Consequently, to maintain the progression in competencies, the need has 

arisen now for implementation of learning ICT subject from grade 6 to 9.    

 

As grade 6 to 9 is a formative study period, it is desirable to arouse curiosity and motivation by 

teaching students more practical areas than theoretical aspects of computing. Therefore, a balance 

between theory and practical areas is achieved. To achieve this balance, the latest technologies have 

been included in the content. 

  

It has been the focus of the curriculum committee to make this balance of competencies in theory 

and practice in order to lay a foundation for higher studies in ICT, to apply the competencies of day 

to day practical situation, to improve ICT literacy and to expose them to international standards.      
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National Goals 

1. Based on the concept of respecting human values and understanding the differences 

between the Sri Lankan multi-cultural society, building up the nation and confirming 

the identity of Sri Lanka by promoting national integrity, national unity, national 

coherence and peace  

2. While responding to the challenges of the dynamic world, identifying and conserving 

the National heritage. 

3. Creating an environment which comprises of the conventions of social justice and the 

democratic life to promote the characteristics of respecting the human rights, being 

aware of the responsibilities, concerning each other with affectionate relationships. 

4. Promoting a sustainable life style based on the people’s mental and physical well-being 

and the concept of human values 

5. Promoting the positive feelings needed for balanced personality with the qualities of 

creative skills, initiative, critical thinking and being responsible 

6. Through education, developing the human resources, needed for the progress of the 

well-being of an individual, the nation   as well as the economic growth of Sri Lanka. 

7. Preparing the people for the changes that occur in a rapidly changing world by adapting 

to it and controlling them; developing abilities and potentialities of people to face the 

complex and unexpected occasions. 

8. Sustaining the skills and attitudes based on justice, equality, mutual respect which is 

essential to achieve a respectable place in the international community. 

 National Education Commission Report (2003).  
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Basic Competencies 

The competencies promoted through the education mentioned below might help to achieve the 

above mentioned National Goals. 

1. Competencies in Communication   

This first set of competencies is made up of four subsets - Literacy, Numeracy, 

Graphics and information communication skills: 

Literacy:  Carefully listening, speaking clearly, and Reading for comprehension, 

writing clearly and accurately. 

 

Numeracy: Using numbers to count, calculate, code and to measure, matter, space 

and time 

 

Graphics: Making sense of line and form, expressing and recording essential 

data, instructions and ideas with line, form, colour, two and three-

dimensional configurations, graphic symbols and icons  

 

ICT Competencies: 
Knowledge on computers, and the ability to use the information 

communication skills learning or work as well as in the private life 

 

2. Competencies relating to the Personality Development 

 Generic skills such as creativity, divergent thinking, initiative, 

decision making, problem-solving, critical and analytical thinking, 

team work, inter-personal relationships, discovering and exploring 

 Values such as integrity, tolerance and respect for human dignity 

 Cognition 

 

3. Competencies relating to the Environment 

   This is the second set of competencies related to the Social, Biological and 

Physical Environments.  

Social Environment:  Awareness, sensitivity and skills linked to being a 

member of society, social relationship, personal 

conduct, general and legal conventions, rights, 

responsibilities, duties and obligations. 

Biological Environment: Awareness, sensitivity and skills linked to the living 

world, man and the ecosystem, the trees, forests,   seas, 

water, air and plant -life, animal and human life.  
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Physical Environment: Awareness, sensitivity and skills relating to space, 

energy, fuels, matter, materials and their links with 

human living, food, clothing, shelter, health, comfort,  

respiration, sleep, relaxation, rest, wastes and 

excretion, media of  communication and transport. 

Included here are the skills in using tools to shape and 

for materials for living and learning 

 

4. Competencies relating to preparation for the world of work 

Employment related skills to maximize their potential and to 

enhance their capacity to contribute to economic development; 

to discover their vocational interests and aptitudes; to choose a 

job that suits their abilities and to engage in a rewarding and 

sustainable livelihood. 

5. Competencies relating to religion and ethics  

This fourth set of competencies laden with values and 

attitudes. It is essential for individuals to assimilate values, so 

that they may function in a manner consistent with the ethical, 

moral and religious modes of conduct, rituals, practices in 

everyday living, selecting the most appropriate.  

6. Competencies in play and use of leisure 

Competencies that link up with pleasure, joy, emotions and 

such human motivations.  These find expression in play, 

sports, athletics and leisure pursuit of many types.  These also 

link up with such values as cooperation, team work, healthy 

competition in life and work. Here are included such activities 

as are involved in aesthetics, arts, drama, literature, 

exploratory research and other creative modes in human 

living. 

7. Competencies relating to ‘Learning to learn’ 

These competencies flow directly from the nature of a rapidly 

changing, complex and interdependent   and crowded world 

whatever one learns, that learning will need updating and 

review. This requires that one should be aware of, sensitive 

and skillful in sustained attention, and be willing to persevere 

and attend to details that matter in a given situation. 
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Objectives of the Subject  

This syllabus enables students to: 

 Develop basic skills useful to access ICT resources. 

 Inculcate basic good practices in the use of ICT resources 

 Inculcate basic computer literacy and develop a base for further pursuit of Information 

Technology and Communication Technology studies. 
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Proposed number of periods for each units 

 

Term Competency Level 
Number of periods 

 

1st Term 

1.1, 1.2 
05 

 

2.1, 2.2, 
04 

 

3.1 
01 

 

2nd Term 

3.1, 
05 

 

4.1, 4.2 
05 

 

3rd Term 

4.2, 
02 

 

5.1 
05 

 

6.1, 6.2 
03 

 

Total 
30 
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Grade 8 Syllabus 

Information and Communication Technology 

Competency Competency Level Content Learning Outcomes 
Duration/ 

Periods 

1. Investigates 

how 

instructions 

and data are 

represented in 

the computer 

1.1. Converts  

decimal numbers  

to   binary 

numbers and vice 

versa 

 Introduction to Number Systems 

o Decimal  and Binary Number System 

o Conversion from   Decimal  to Binary 

o Conversion from Binary  to Decimal 

i. Describes  Number systems 

with 10 and 2 as the base 

ii. Converts decimal integers to 

binary and vice versa 

03 

 

 

1.2. Appreciates the 

working logic 

(binary concept) 

in computers 

 Method of data representation   using 0 and 1 

 Binary data flow among the computer 

components   

i. Represents positive decimal 

integers in binary 

ii. Explains the method of 

displaying a character (Alpha 

numeric symbolic)/ image on 

the monitor using a bitmap 

 

02 

2. Uses 

computers 

efficiently and 

effectively with 

operating 

system 

 

 

2.1. Uses Operating 

System for 

configuring and 

applying settings 

 

 Regional settings: Date, Time, Currency, 

Number format 

 File properties 

 File Search 

i. Makes settings: Date, Time, 

Currency, Number format 

ii. Sets File properties: read-only, 

hidden, location, size  

iii. Searches files with extension 

02 

2.2. Explores basic 

troubleshooting  

of computers and 

maintenance 

procedures 

(hardware and 

software ) 

 Troubleshooting of simple  computer faults 

 Hardware  issues (keyboard, mouse, power 

cable, network cable, VGA cable) 

 Sound output issues (speaker connectivity, 

check the volume) 

 Ports connectivity (PS/2, USB, Micro USB, 

VGA, HDMI, Parallel, RJ45, Memory Card 

Reader) 

 Troubleshooting and resolving of relevant 

computer software issues 

 Corrupt software 

 Blank desktop 

 

i. Troubleshoots and resolves 

relevant hardware issues 

ii. Troubleshoots and resolves 

relevant software problems 

 

02 
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3. Use of word-

processing 

software in day 

today activities 

3.1.Uses basic 

functions of word 

processing 

software in 

creating a 

document 

 Create, open, save and close a document 

 Formatting of Text 

 Inserting files/objects (text, picture, shapes, 

clip art, word art etc.) 

 Inserting a table 

 Spelling and grammar check 

 Lists 

 

i. Creates a formatted document 

using word processing 

software 

 

 

 

06 

4. Uses flow chart  

to solve simple 

problems with 

sequence, 

selection and 

develop 

programs 

(Using Scratch)  

4.1. Analyzes the 

problem 
 Identification of input, process and output 

steps 

 Identification of applications created for 

mobile and smart devices   

 Documentation of solution using flow charts 

i. Analyzes the problems in 

simple day to day life 

ii. Explains the problem with a 

block diagram 

iii. Describes applications in 

mobile and smart devices 

 

 

 

02 

 

4.2. Uses control 

structures to 

develop simple 

programs 

 Introduction to  simple algorithm and control 

structures of Selections 

 Developing simple programs (Sequence and 

Selection) using visual supports of 

programming language (using an Interface) 

 

i. Describes control structures 

(selection only) 

ii. Applies control structures to 

solve simple day to day 

problems 

 

 

05 

 

5. Uses a software 

package for  

physical 

computing to 

implement  

programming  

logic 

 

5.1.Uses a simple 

hardware device  

to implement  

physical 

computing 

 

 Components of physical computing device 

 Controllable devices 

 Turning on/off LEDs 

 Design LED patterns with simple programs 

 

 

 

 

 

 

i. Writes a program to operate 

external circuits using two 

logic levels (yes/no, on/off) 

ii. Implements programs on 

physical devices. Example: 

Turning On/Off the LEDs with 

passing values 

05 
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6. Explores  

educational 

information 

using the 

Internet 

6.1 Searches 

information on 

the Internet 

 Search Engines: Google, Yahoo etc. 

 Educational browsers 

 

i. Identifies Search Engines 

ii. Searches information using the 

Internet 

 

01 

6.2. Creates websites 

with advanced 

features 

 Tags, Elements, Attributes, Text formatting 

etc. 

 Advanced features in hyperlinks 

 

i. Designs websites as per 

specifications 

ii. Develops websites as per 

design 

02 

Total 30 
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 Learning Teaching process  

 

Information and Communication Technology is rapidly changing subject and student eager to use 

latest technology. Provide actual hand on experience for each student using practical exercises. 

Allow them to convince theoretical basis through practical exercises.  

It is essential that the proposed method of teaching should be student-centered as this subject is 

essentially practice-oriented. There is need for special attention to be paid to the encouragement of 

the student for self-study. Guide the student to apply achieved ICT competencies to improve the 

learning process of other subjects.  

Primitive social values and legal constraints related to the subject carry with them the imperatives 

of a sense and spirit of self-discipline. It is essential that the learning-teaching evaluation process is 

so organized as to highlight the importance of computer use. 

Students should be motivated and inspired to attend group activities to learn new things and 

collaborative activities to share and convince their findings with others through ICT and manual 

mediums.  
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Competency 1   : Investigates how instructions and data are represented in the computer 

Competency Level 1.1: Converts decimal numbers to binary numbers and vice versa 

Time   :  03 periods 

Learning Outcomes: 

 Describes  Number systems with 10 and 2 as the base 

 Converts decimal integers to binary and vice versa 

 

Contents: 

 Introduction to Number Systems 

 Decimal and Binary Number System 

 Conversion from   Decimal  to Binary 

 Conversion from Binary  to Decimal 

 

Concepts and terms to be highlighted: 

 Number system 

 Binary Numbers 

 Decimal Numbers 

 Decimal number system has base 10 as it uses 10 digits from 0 to 9 

 Binary number system has base 2 as it uses 2 digits which are 0 and 1 

 Conversion of decimal and binary numbers 

Guidance for lesson plans:  

 Place value of decimal numbers  

 Construct binary numbers system using above structure 

 Discuss how to convert decimal numbers to binary numbers 

 Discuss how to convert binary numbers to decimal numbers 

Guidance for assessments and evaluations: 

 Give enough questions to get familiar with the decimal to binary and binary to decimal 

conversions 

Quality inputs: 

 Abacus, Internet facility, Presentations on Number systems 

 https://www.includehelp.com/computer-number-systems.aspx 
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Reading Material 

Decimal numbers and Place value  

Decimal number system has only ten (10) digits from 0 to 9. Every number 

(value) represents with 0,1,2,3,4,5,6, 7, 8 and 9 in this number system. The 

base of decimal number system is 10, because it has only 10 digits.  

The abacus can use to identify placement values. 

.  

Binary Numbers 

Binary number system has base 2 because it uses two digits of 0 and 1 in binary number system.  

 

Conversion from Decimal to Binary 

1. Divide the number by 2. 

2. Get the integer quotient for the next iteration. 

3. Get the remainder for the right side 

4. Repeat the steps until the quotient is equal to 0. 

. 

 

Fig 1.1. 1 Placement values of number 162 

 

Fig 1.1. 2 Placement values of Binary numbers  

Fig 1.1. 3  Conversion of Decimal 19 to Binary 
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Conversion from Binary to Decimal  

1. Write down the binary number. 

 

2. List the powers of two from right to  

Left. 

 

3. Write the digits of the binary number 

below their corresponding powers. 

 

4. Connect the digits in the binary 

number with their corresponding 

powers. 

 

 

5. Write down the final value of each power of two 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Fig 1.1. 4  Conversion from Binary to Decimal 
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Competency 1: Investigates how instructions and data are represented in the computer 

Competency Level 1.2: Appreciates the working logic (binary concept) in computers 

Number of Periods: 02 periods 

Learning Outcomes: 

 Represents positive decimal integers in binary 

 Explains the method of displaying a character (Alpha numeric symbolic)/ image on the 

monitor using a bitmap 

 

Contents: 

 Method of data representation  using 0 and 1 

 Binary data flow among the computer components 

 

Concepts and terms to be highlighted: 

 Data representation 

 Binary data Flow 

Guidance for lesson plans: 

 How computers see the world 

 Bits and bytes and binary 

 Representing data 

o Representing text in Computer 

o Representing images in Computer 

o Bitmaps 

o Representing  colours in image 

         Representing sound in computer 

Guidance for assessments and evaluations: 

 By using a computer as a model explain how and at which point computer will do the binary 

conversion of input numbers. Can do this as part of a drama, and they can show how and 

which data traverse through one point to another. 

Quality inputs: 

 Bit and byte size model using bulbs 

 Manually created simple bitmap image by using black and white papers. 

 https://www.quora.com/How-does-the-computer-understands-images-and-audios 

 https://www.cs.cmu.edu/~fgandon/documents/lecture/uk1999/binary/HandOut.pdf 
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Reading Material 

How computers see the world 

Computers are machines that do stuff with information. They let you view, listen, create, and edit 

information in documents, images, videos, sound, spreadsheets and databases. 

To make computers easier to build and keep them reliable, everything is represented using just two 

values.  

You may have seen these two values represented as 0 and 1, but on a computer they are represented 

by anything that can be in two states.  

Bits and binary 

Computers use binary - the digits 0 and 1 - to store data. A binary digit, or bit, is the smallest unit of 

data in computing. It is represented by a 0 or a 1.  

Binary numbers are made up of binary digits (bits),  

eg the binary number 1001. 

Computers use electrical signals that are on or off, so they have to see everything as a series of ones 

and zeros. This data is represented as a sequence of 1s and 0s (on and off).  

 

                                 Fig 1.2.  1 Binary number 10101000 is represented as a sequence of 1s and 0s (on and off). 

All data that we want a computer to process needs to be converted into this binary format. 

Bits and bytes 

Bits can be grouped together to make them easier to work with.  

 Nibble - 4 bits (half a byte) 

 Byte - 8 bits (A group of 8 bits is called a byte) 

 Kilobyte (KB) - 1000 bytes 

 Megabyte (MB) - 1000 kilobytes 

 Gigabyte (GB) - 1000 megabytes 

 Terabyte (TB) - 1000 gigabytes 
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Computer uses 8 bits (I byte) to represent a number or a character. 

Representing data 

All data inside a computer is transmitted as a series of electrical signals that are either on or off.  

Therefore, in order for a computer to be able to process any kind of data, including text, images and 

sound, they must be converted into binary form 

Representing text in Computer 

When any key on a keyboard is pressed, it needs to be converted into a binary number so that it can 

be processed by the CPU and the typed character appears on the screen.  

 

The letter ‘A’ has the binary number 0100 0001 (this is the 

denary number 65)  

A code where each number represents a character can be 

used to convert text into binary. One code we can use for 

this is called ASCII. The ASCII code takes each character 

on the keyboard and assigns it a binary number. For 

example: 

 the letter ‘a’ has the binary number 0110 0001 

(this is the denary number 97)  

 the letter ‘b’ has the binary number 0110 0010 

(this is the denary number 98) 

 the letter ‘c’ has the binary number 0110 0011 

(this is the denary number 99) 

 Fig 1.2.  2   when data, including text, images and sound, converted into binary 

converted into binary 

 

Fig 1.2.  3  Conversion of  The letter ‘A’  into binary 
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ASCII code can only store 128 characters, which is enough for English language but not enough for 

some other languages. If you want to use larger alphabets such as Japanese, Chinese and Mandarin 

then more characters are needed. Therefore another code, called Unicode, was created. This meant 

that computers could be used by people using different languages. 

Representing images in Computer 

Graphics on a screen are made up of tiny dots called pixels. The more pixels on the screen, the 

higher the resolution and the better the quality of the picture will be. The higher the image 

resolution, the more memory is needed to store the graphic. 

 

 

 

 

 

 

 

 

 

Bitmaps 

Bitmap images are organized as a grid of colored squares called pixels. When zooming in or 

enlarging a bitmap image, the pixels are stretched and made into larger blocks. This is why bitmap 

images appear as poor quality when enlarged too much. 

Common bitmap image file types include JPEG, GIF and PNG. 

If we say that 1 is black (or on) and 0 is white (or off), then a simple black and white picture can be 

created using binary.  

This example shows an image created in this way:  

 

        

        

        

Increase resolution will increase the picture quality (clearness) 

Fig 1.2.  4   the higher the resolution and the better the quality of the picture will be 
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Representing colors in image 

The system described so far is fine for black and white images, but most images need to use 

colours. 

 1 bit per pixel (0 or 1): two possible colors 

 2 bits per pixel (00 to 11): four possible colors 

 3 bits per pixel (000 to 111): eight possible colors 

 4 bits per pixel (0000 – 1111): 16 possible colors 

 16 bits per pixel (0000 0000 0000 0000 – 1111 1111 1111 1111): over 65 000 possible colours 

Representing sound in computer 

Sound needs to be converted into binary for computers to be able to process it. To do this, sound is 

captured,  usually by a microphone, and then converted into a digital signal. 

A sound wave like this can be sampled (get value at the time) at each time sample point:  

 

                                      Fig 1.2.5   sound wave . 

 

        

        

        

        

        

0 0 0 1 1 0 0 0 

0 0 1 0 0 1 0 0 

0 0 1 0 0 1 0 0 

0 1 0 0 0 0 1 0 

0 1 1 1 1 1 1 0 

0 1 0 0 0 0 1 0 

1 0 0 0 0 0 0 1 

1 0 0 0 0 0 0 1 
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Time  1 2 3 4 5 6 7 8 9 10 

value 8 3 7 6 9 7 2 6 6 6 

Binary 

value 
1000 0011 0111 0110 1001 0111 0010 0100 0110 0110 
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Competency 2: Uses computers efficiently and effectively with operating system 

Competency Level 2.1: Uses Operating System for configuring and applying settings 

Number of Periods: 01 period 

Learning Outcomes: 

 Makes settings: Date, Time, Currency, Number format 

 Sets File properties: read-only, hidden, location, size  

 Searches files with extension 

Contents: 

 Regional settings: Date, Time, Currency, Number format 

 File properties 

 File Search 

 

Concepts and terms to be highlighted: 

 Settings on operating system 

 Sets file properties 

 File extension 

Guidance for lesson plans: 

 Provide instructions to access the Regional settings in the computer 

 Discuss on files properties 

 Provide instructions to identify file extensions 

 Group the students and provide them various types of files and ask the group them and 

present their findings 

Guidance for assessments and evaluations: 

 Divide the class into groups and provide assignments, to make the regional settings on a 

computer and collect various files and group them according to  the types present them  

Quality inputs: 

 Computers, Internet facility,  a collection of different types of files 

 https://www.cnet.com/how-to/windows-10-settings-menu-the-time-language-tab/ 
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Reading Material 

How to Change Country or Region Home Location in Windows 10 

To Change Your Country or Region Home Location in Settings 

1. Open Settings, and click/tap on the Time & language icon. 

2. Click/tap on Region & language on the left side, select your Country or region (ex: Sri Lanka) on 

the right side. (See screenshot below) 

3. You can now close Settings if you like. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Settings icon 

Fig 2.1. 1 The window of the  settings 

Fig 2.1. 2 Country or region and Language setting window 
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How to Change Date and time in Windows 10 

To Change Your Date and Time in Settings 

1. Open Settings, and click/tap on the Time & language icon. 

2. Click/tap on Date & Time on the left side, select your Time Zone (ex: Sri Jayewardenepura) on 

the right side. (See screenshot below) 

3. Click on the Date and Time Formats  

4. Change date and time  

5. You can now close Settings if you like. 

Fig 2.1 3 selecting  the  country 
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How to Change Currency in Windows 10 

To Change Your Currency in Settings 

1. Open Settings, and click/tap on the Change date, time or number formats icon. 

2. Click on the Additional Settings button on the Region window 

3. Select the Currency tab, type a Currency symbol  (ex. Rs.) and tap on the Apply button and OK 

button 

4. You can now close Settings if you like. 

 

1 

 

 

 

 

 

 

Fig 2.1. 4 selecting time zone 

Fig 2.1. 5 selecting date and time format 

Fig 2.1. 6 The window of settings 
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2               3 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

How to Change Number Formatting in Windows 10 

To Change Your Number Formatting in Settings 

1. Open Settings, and click/tap on the Change date, time 

or number formats icon. 

2. Click on the Additional Settings button on the Region 

window 

 

 

 

 

 

Fig 2.1. 7 The window of date and time selecting Fig 2.1. 8 The window of currency selecting 

Fig 2.1. 9 The window of number formatting 
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3. Select the Numbers tab, type a Decimal symbol  (ex “.” ), do necessary changes for other tap on 

the Apply button and OK button. 

4. You can now close Settings if you like. 

Sets file properties 

Hiding a file 

1. Open File Explorer. 

2. Navigate to the file or folder you want to hide. 

3. Right-click the item and click on Properties. 

4. On the General tab, under Attributes, check the Hidden option. 

5. Click Apply. 

 

 

6. If you're hiding a folder with files and subfolders, make sure to select the Apply changes to 

this folder, subfolders, and files option. 

  

Fig 2.1.10 the window of file explorer 

Fig 2.1. 11 window of secret files properties 
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7. Click OK. 

 

 

 

 

 

 

 

 

 

8. Click OK again to complete the task. 

 

Making hidden files and folders visible again 

Open File Explorer, click on the View tab and make sure to check the Hidden items option. Then 

you can browse your hidden items as you would normally do with other content. 

Type the complete path to the hidden folder or file you want to open and press Enter. For example: 

C:\Users\admin\Desktop\Files\Secret Files\My School.ppt 

Fig 2.1.11 The window of Confirm Attribute Changes 

Fig 2.1. 12 making hidden files and  folders visible again 
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File Search  

Search by File Extension, Date and Size in Windows 

1. Open File Explorer and click in the Search box. 

2. Search Tools will appear at the top of the Window which allows the choosing of a Type, a 

Size, Date Modified, Other Properties and Advanced search. 

3. Alternatively, type the search criteria into the box in the top right of the screen and press 

Enter. 

Example searches are: 

1. File name – Ex : ICT Grade 8  

2. Size - Ex : 25MB 

3. Type  - Ex : .pdf 

4. Date Created – 2017/10/23 

5. Date Modified – 2017/11/22 

6. Author - CHAMARI 

7. Location - Colombo 

 

 

 

 

 

 

 

 

 

Fig 2.1. 13 Window of file explorer 

Fig 2.1.14 choosing details 
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Competency 2    : Uses computers efficiently and effectively with operating system 

Competency Level 2.2.: Explores basic troubleshooting of computers and maintenance procedures   

(hardware and software) 

Number of Periods   : 02 periods 

Learning Outcomes: 

 Troubleshoots and resolves relevant hardware issues 

 Troubleshoots and resolves relevant software problems 

 

Contents: 

 Troubleshooting of simple  computer faults 

 Hardware  issues (keyboard, mouse, power cable, network cable, VGA cable) 

 Sound output issues (speaker connectivity, check the volume) 

 Ports connectivity (PS/2, USB, Micro USB, VGA, HDMI, Parallel, RJ45, Memory Card 

Reader) 

 Troubleshooting and resolving of relevant computer software issues 

 Corrupt software 

 Blank desktop 

 

Concepts and terms to be highlighted: 

 Troubleshooting 

 Computer faults 

 Hardware  issues 

 Ports connectivity 

 Corrupt software 

 Blank desktop 

 

Guidance for lesson plans: 

 Explain the troubleshooting  

 Provide instructions to identify hardware and software issues on the computer 

 Guidelines for  Troubleshooting and resolving of relevant computer hardware and software 

issues 

 Group the students, provide them different types of software and hardware issues and ask 

them to solve using the knowledge gained.  

Guidance for assessments and evaluations: 

 Randomly remove cables of each computer and separate hardware component of each 

computer. 

 Divide the class into groups and provide assignments to find and resolve each hardware 

issues on computer. 

 

Quality inputs: 

 Computer hardware , Internet facility,  Relevant software  

 https://www.computerhope.com/jargon/t/troushoo.htm 
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Reading Material 

 

Troubleshooting 

Troubleshooting is the process of figuring out how to solve a computer problem. 

 

Computer troubleshooting overview 

Following these steps can help identify or solve most 

computer problems. 

1. Is the computer turning on? 

2. Any Error messages? 

3. Reboot the computer 

4. Has any new hardware or software been added? 

5. Has the computer moved? 

6. Have there been any power outages or electrical 

storms? 

7. Reconnect and check power cords 

8. Update drivers or install latest patches 

9. Scan for malware and viruses 

10. When was the computer last running with no problems? 

11. Other computer hardware and software troubleshooting 

 

Hardware issues 

 Keyboard 

 Mouse 

 power cable 

 network cable 

 VGA cable 
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Sound output issues  

 Speaker connectivity 

 Check the volume 

 

Ports connectivity  

 PS/2 

 USB 

 Micro USB 

 VGA 

 HDMI 

 Parallel 

 RJ45 

 Memory Card Reader 

 

Resolving of relevant computer hardware issues 

i. Make sure the device is connected to the computer. If not, connect it to the computer.  

ii. If using a wireless device, try changing the batteries. 

iii. Ensure that all cables are properly connected. 

iv. Turn off and turn on the device again. 

v. Restart the computer 

vi. Check the volume 

 

Computer software issues 

i. Blue Screen of Death (BSoD) 

ii. Missing DLL File 

iii. Applications That Won't Install 

iv. Applications Run Slowly 

v. Abnormal Applications Behavior 

vi. Unable to install a software program 

vii. Error during installation 

 

 

 

 

Fig 2.2. 1 Power cord connection 
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Troubleshooting and resolving of relevant computer software issues 

i. Verify software volume control settings 

ii. Update drivers or install latest patches 

iii. Scan for malware and viruses 

 

Corrupt software  

When software is not installed correctly or due to malware program they can become corrupt. When 

software becomes corrupt, it cannot be opened without errors and in some cases, may not be able to 

be recovered or fixed without the file being replaced by a backup. 

 

 

Blank desktop 

If the computer is on but the screen is blank, there may be an issue with the connection between the 

computer and the screen. First, check to see if the monitor is plugged into a power point and that the 

connection between the monitor and computer hard drive is secure. If the problem is on a laptop, 

then you may need to get a professional to fix it as some of the internal wires may be worn. 
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Competency 3    :  Use of word-processing software in day today activities 

Competency Level 3.1: Uses basic functions of word processing software in creating a                                                        

        document  

  

Time     : 6 periods  

Learning Outcomes:  

 Creates a formatted document using word processing software 

o Applies suitable text formatting   

o Manipulates graphics and draws simple shapes  

o Creates tables to insert data  

o Formats tables   

o Edits tables  

o Checks spelling and grammar of a document 

 

Content  

 Create, open, save and close a document 

 Formatting of Text 

 Inserting files/objects (text, picture, shapes, clip art, word art etc.) 

 Inserting a table 

 Spelling and grammar check 

 Lists  

 Formatting text  

 Graphics: Insertion and formatting   

 Shapes : Insertion and formatting  

 Insertion of tables  

 Column width and height   

 Deletion, insertion, splitting and merging of cells  

 Spelling and grammar checking  

 

Concepts and terms need to be highlighted:  

 Outline of facilities available: Creation, editing, storing, sharing, use of graphics, 

copies  

 Familiarization of the user interface  

 Short-cuts for menu sequences: to open, close, save, copy, cut, paste, undo, redo  

 Various types of formatting: Text (fonts, boldface, italics..), paragraph (center, right 

and left alignment, justification, bullets and numbers), page (margins, orientation)  

 Adjustment of column width: exact fit  

 Continuation of title headings to succeeding pages  

 Merging of cells as the final editing  

 Limitations in built-in spellchecker and grammar checker.  
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Guidance for lesson plans:  

 Discussion of the use of the software for its basic operations.  

 Discussion and demonstration of basic operations.  

 Different ways of opening a word processed document: through the software, by double 

clicking the document, through right-clicking.  

 Teacher demonstration of the tools of formatting.  

 Provide Activity sheets created to cover formatting techniques.  

 Provide meaningful exercises to enable them to learn in context.  

 Teacher demonstration of the tools for tables.  

 Provide Activity sheets created to cover working with tables.  

 Provide meaningful exercises to enable them to learn in context.  

 Provide documents with spelling mistakes to be typed.  

 Apply spell-checker to correct mistakes. 

 

 

Guidance for assessments and evaluations:  

 Opening of a saved document on the hard disk. 

 Editing the document. 

 Saving in given formats. 

 Provide unformatted text in soft form to carry out specified formatting.  

 Provide already done documents to recreate them using software.  

 Provide a hard copy of a tabulated data with formatting like merged cells etc.  

 Provide soft copies of documents with spelling mistakes to be corrected.  

 

Quality inputs:   

 Computer with word processing software 

 https://www.tutorialspoint.com/word/word_explore_window.htm 
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Reading Material 

Word Processing Software 

Several popular word processing software are available. Some need to be purchased (Licensed) and 

some are Free and Open Source Software (FOSS). 

 

 

 

 

Eg: 

 

 

Get familiar with Word Processing Software 

 

FOSS

Software -Libre Office Writer 

Producer- The document foundation

software - Open Office Writer 

producer - Apache Software 
foundation

License

Software  - Microsoft Office 
Word producer - Microsoft 

Software  - iWork Pages 

producer - Apple
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1 Title Bar - The top most bar on a Microsoft Office word 2010 window is the Title Bar. The name 

of the opened document will appear here.  

2 Ribbon - The special feature of the ribbon is that the items are shown as Icons. Features of the 

ribbons (File, Home, Insert etc.) are called Tabs. 

Some features of the Home tab shown below 

 

                             Fig 3.1 2  Some features of the Home tab 
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3. Quick Access Tool Bar - (Figure 6.4) -Quick Access Tool Bar contains quick (frequently using) 

commands such as opening a new document, saving or opening a document, Zooming, Undo, Redo, 

etc. 

 

 

 

 

 

 Fig3.1.3 Quick Access Tool Bar 

 

4. Dialogue Box launcher - Dialogue Box launcher shows additional tools. Dialogue 

boxes can be opened by clicking the arrow at the right hand side of the group name. Apart 

from the tools which appear in the Ribbon, Dialogue boxes provide several other useful 

tools in document preparation.    

 

5. Status Bar - This is at left bottom of Microsoft Word window.  This shows the number of 

pages and words of the document, language used, view buttons, etc. 

 

6. Scroll Bar - used to go up and down of the document.             

 

7. Zoom  - Zoom can adjust the size of the pictures on the screen. This does not affect the 

original document. 

 

 

8. View Buttons 

 

a. Reading - In Microsoft Word the “Reading view” allows you to view (not edit) a 

document in full screen without any of the toolbars. To exit Full Screen Reading 

press the escape key. 

b. Normal view - The Normal view is the default view of the program. 

c. Web Layout - In Microsoft Word the Web Layout shows your document in a full-

screen with all the toolbars and the ability to edit. 

d. Outline view - makes viewing complex documents easier by giving summarized 

view with headings and hide paragraphs denote4d with a “+”  symbol. 

 

 

 

Create a document 

Even though there is a new page when Word software is open, the user has to get a new page for 

another document. 

Undo 

https://www.computerhope.com/jargon/e/esc.htm
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   File → New → Blank     Document    

 (Ctrl + N) → Blank     Document    

 

Open a document 

The user may need to open a file saved in the computer or in an external storage medium. To open a 

document 

 Select ‘File  → Open’ or press (Ctrl+O) from the key board 

 Select the saved file in the ‘Look in’ location in the open dialog box.  

 Select the document from the window 

 Click ‘Open’ button. 

Close a document 

It is a good practice to close the document if it is unwanted, opened files will be a disturbance for 

the performance of the computer. 

 Select  ‘File  → Close’ 

 (Ctrl + W)  

 Select small cross which appears on the top right corner of the title bar. 

 

 

 

Save a document 

It is essential to save the document in a proper place with a proper name.  This enables the user to 

find the saved document easily. 

 Select File → Save  or  press (Ctrl + S) from the key board 

 select a saving location using ‘Save in’  

 type a proper name for the document in ‘File name’  

 click ‘save’ button 

Saving the file by another name 

Once the user save the document by giving a name, it is called ‘File’. The user can save the file by 

another name in another place. Then the user will get two files by the existing name and the new 

name.  

 Select       File  → Save as 

 Select a Saving Location from ‘Save  in’ 

 Type a proper name for the document in ‘File name’   

 Click Save button 

Text formatting 

User is able to perform the following;  

 Change Font Size.  
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Select the text  go to Home tab  Font group  select desired font size from the “font 

size” drop down list. 

 

 

 Change Font Style - Make letters Bold or Italic.  

Select the text  go to Home tab  Font group  select desired font style from the “font” 

drop down list. 

 

 Underline letters.  

Select the text  go to Home tab  Font group  select “U”.  Or Select the text (ctrl + U) 

 

 Use different types of fonts in different languages.  

Select the text  go to Home tab  Font group  select desired language-font from the 

“font” drop down list. 

 

 5.   Change font color. 

Select the text  go to Home tab  Font group  select desired color from the drop down 

list next to “Font color” icon. 

 

Paragraph formatting 

Text alignment 

i Left Align     

ii Center Align       Select the text  click Home tab  

paragraph group    select desired alignment 

iii Right Align                                         Line and Paragraph spacing 

iv Justify    

Inserting Shapes 

This will allow you to add variety of shapes, such as boxes, circles, and arrows, to your document. 

To insert a shape 

Click on position where you want to insert a shape. 

 Select Insert tab → Illustration group  Shapes option  select the desired shape from the 

gallery 

 The cursor changes to + sign. Click, hold and drag the mouse to draw the shape. 

 You can also enter text inside the shape by selecting “Add text” option from the context 

menu.  

 To format this text can use 

o Options in the font group on the HOME tab 

o Options on the DRAWING TOOLS on the FORMAT tab 

 When you select some shapes, you may get yellow handles. These can be used to modify the 

shape. 

 

 

 Word allows to control which shape should appear on top, when there is more than one 

shape inserted. 
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o Right click on the shape you want to move. 

o From the context menu, select the desired option, like “bring to front” or “Send to 

back” or any of their sub menu options / select the shape, and on the format tab, use 

the “bring forward Or “Send backward” command options in the arrange group. 

Inserting pictures 

 Place the cursor at the position where you want to insert the picture. 

 Click the insert tab, and click the pictures button in the illustration group. 

 Then insert picture dialog box opens 

 from this select the folder which contains the image you need 

 Select the desired image and click insert button. 

 To insert a picture from the internet 

 Click insert tab 

 Click online pictures button in the illustration group. 

 Then search the image that you want, by using the search engine opens. 

 Select the picture and click insert button. 

 

 

 

 

 

 

Formatting a picture 

When click on the picture you inserted, a new format tab appears under picture tools. This tab has 

number of options to change the style and appearance of your image.  

 

 Crop image – removing unwanted parts of an image. 

o Select the image 

o Click the format tab appears under picture tools. 

o In the size group, click the crop command. 

o The cropping handles will appear around the image. Click, hold and drag a handle to 

crop the unwanted part of the image.  

 

 Appearance of the image 

o These options are available in the adjust group and the picture style group on the 

format tab. 

o Adjust group – Corrections, color, artistic effects 
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o Picture style group – frames, borders etc… 

 

 Wrap text 

o Text-wrapping is a feature which automatically starts a new line when a word in 

sentence reaches a border (of a picture, or a text box), there are different options 

available …. 

o Select the image 

o Click format tab that appears under picture tools. In the arrange group click the wrap 

text command 

o Or select wrap text opting from the context menu which appears when right click on 

the image. 

Inserting word art 

Word art gallery includes different styles that can be applied to any text. 

 Place the cursor at the position where you want to insert the word art. 

 Click the INSERT tab. 

 Click word art button in the text group and select a word art style. A placeholder appears in 

the document. 

 Type the text you want to appear in word art. 

 

 Formatting word art 

 

o Use the options available on the FORMAT tab under DRAWING tools. Under this 

section you can change 

 Text fill 

 Text outline 

 Text effects 

 Inserting text boxes 

    Text box can be used if you want to draw attention to specific text. 

 Place the cursor at the position where you want to insert the text box. 

 Click insert tab, text box command in the text group / Select Insert tab → Illustration 

group  Shapes option  select the text box from the gallery 

 Draw the text box. 

 Blinking cursor will appear inside the text box, then you can type the text that you want 

to appear in text box. 

 

 Formatting a text box 

 

o Change shape – Format tab  Insert shapes group  select edit shape command  

select change shape option in the menu and select desired shape. 

o Change shape fill color. 

o Change shape outline. 
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o Add shape effects such as shadows, glows etc.. listed under shape effects option 

o Changing shape of the text – FORMAT tab word Art style group  text effects 

option  transform option  select an effect from the sub menu. 

o  

Inserting a table 

There are different ways to insert a table 

 Using grid 

o Insert tab  Tables group  table  option 

o Table grid appears  drag the mouse to select number of rows and columns  click 

the mouse button  empty table will insert into the document. 

 

 Using the insert table option 

o Insert tab  Tables group insert table option Insert Table dialog box will 

appears enter the number of rows and columns  click ok  empty table will 

insert into the document. 

 

 Using quick tables 

o Insert tab  Tables group  Quick Table option  select the desired template  a 

table with selected template inserted  Enter your data into the table. 

 

 Drawing a custom table 

o Insert tab  Tables group  draw table optionclick and drag the mouse to draw 

rows and columns as you want. 

 

 

 Converting text to a table 

o Select the text  

o Insert tab  Tables group  select convert text to table option  select the number 

of rows and columns  click ok  selected text will appear in a table. 

 

Modifying a table  

 Insert rows / columns / cells 

o Click the cell, row, column where you want to insert a new blank row / column / 

cell. 

Right click, select insert in the context menu, and then select appropriate insert 

option.  

 

OR 

o Click the cell, row, column where you want to insert a new row / column / cell  

layout tab  rows and columns group  select insert option  select required 

option in the drop down menu 
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 Delete rows / columns / cells 

o Click the cell, row, column where you want to delete an existing row / column / cell. 

o Right click, select delete in the context menu, and then select the appropriate delete 

option from the delete dialog box  

OR 

o Click the cell, row, column where you want to delete an existing row / column / cell 

 layout tab  rows and columns group  select delete option  select required 

option in the drop down menu 

 

 Merging cells 

o Select the cells to be merged  layout tab  in the merge group, click the merge 

cells option. 

 

 Splitting cells 

o Select the cell to be split  layout tab  in the merge group, click the split cells 

option  split cells dialog box appears  specify the number of rows and columns 

 click OK. 

Formatting a table 

 Table styles 

o Click on the table or select the table  Design tab  table styles group   select 

the style want to apply. 

 

 Changing row height / column width 

o Click in the row or column to be change. 

o Click layout tab  in the cell size group  click table row height / table column 

width scroll box  change the width / height as desired. 

o  

 

 

 Applying borders 

o Select the cells / table to apply a border  design tab  borders group, click the 

borders drop down menu arrows select the border. 

 

OR 

 

 Select the cells / table to apply a border  design tab  borders group, click the borders 

drop down menu arrows  click borders and shading  select border setting , line style , 

line color, line width , shading from the shading tab and click ok. 

Creating lists 

 Bulleted list – usually uses when the order of items in the list does not matter. 

o Select the list  home tab  Paragraph group  click bullets drop down menu  

select a bullet from the bullet gallery. 
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 Numbered list – usually uses when the order of items is important. 

o Select the list  home tab  Paragraph group  click numbers drop down menu  

select a number style from the gallery. 

Spelling and grammar check 

 Grammar Mistakes – A blue wavy line indicates grammatical mistakes. 

Spelling & Grammar tool allows you to check and deal with Spelling & Grammar mistakes in 

an entire or in a part of the document. 

 Spelling mistakes – A red wavy line indicated misspelled word. 

o Place the cursor at the position where you want to start spelling check. 

o Click REVIEW tab  Proofing group  click Spelling & Grammar button  the 

Spelling task pane will appear on the right side of the document window 

o Misspelled word is highlighted and the suggestions are displayed in the suggestions 

box. 

 Click the correctly spelled word in the suggestions box 

 Click change to change the word, or click change all to change the word in 

the entire document. 

 Click ignore if no correction is needed, or click ignore all to continue 

checking the document but leaving all instances of the selected word 

unchanged throughout the document. 

 Click add to, include the selected word into the dictionary as a new word. 

 When spelling check is completed a message will appear by saying the 

corrections are done, by clicking OK the message you can continue to the 

document. 

 

 Thesaurus - this will provide list of synonyms for a given word, and can replace a word 

with a similar word provided in the list. 

o Select the word you want to get synonyms. 

o Click REVIEW tab  click Thesaurus in the proofing group  Thesaurus task pane 

appears to the right of the document window. 

o Select a word from the list of synonyms move mouse over it, click insert or copy 

from the drop-down list replace selected word with it. 

 

 Change case – Change the appearance (Capital, Simple) of already typed text. 

o Select the text for which you want to change the case Click Home tab  

click Change Case in the Font group  select the desired option. 

 Sentence case - To capitalize the first letter of a sentence and leave all other    

letters as lowercase, click. 

  Lowercase - exclude capital letters from your text, click. 

 UPPERCASE  - capitalize all of the letters, click. 

 Capitalize Each Word - capitalize the first letter of each word and leave the 

other letters lowercase, click. 

 tOGGLECASE - change lowercase characters to uppercase and 

uppercase characters to lowercase. 
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Competency:  4 Uses flow chart to solve simple problems with sequence, selection and develop    

programs (Using Scratch) 

 

Competency Level 4.1: Analyzes the problem 

Time: 2 periods  

Learning Outcomes:  

 Analyzes the problems in simple day to day life 

 Explains the problem with a block diagram 

 Describes applications in mobile and smart devices 

 

Content: 

 Identification of input, process and output steps 

 Identification of applications created for mobile and smart devices   

 Documentation of solution using flow charts 

 

Concepts and terms need to be highlighted:  

 Analyzes the problem 

 Block diagram 

 Identification 

 Flow chart 

 

Guidance for lesson plans:  

 Discuss with students about control structure (Sequence, selection, Iteration) Divided the 

students in groups and ask a problem that they face and analysis and solve. Ask the students 

group to represent the problem with flow chart.  

 

Guidance for assessments and evaluations:  

 Give a problem to the student group to analysis and ask the students groups to represent the 

problem with flowchart. 

Quality inputs:   

 Activity Sheet 

 https://www.tutorialspoint.com/programming_methodologies/programming_methodologies

_flowchart_elements.htm 
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Reading Material 

Represent the analytical thinking (only sequence, Selection) with flow chart 

All make decisions on a daily basis. What should I have for breakfast? Where should I go this 

weekend? Every time we make a decision over base it on some criterion. After making this 

decision, over act on it. Thus decision-making is a two-step process – first deciding what to do 

based on a criterion, and secondly taking an action 

The selection control structure allows one set of statements to be executed if a condition is true and 

another set of actions to be executed if a condition is false. 

 

Traffic lights alternate the right of way accorded to users by displaying 

lights of a standard color (red, amber (yellow), and green)  

The green light allows traffic to proceed in the direction denoted. 

The amber (yellow) light warns that the signal is about to change to red. 

The Red light do not allows traffic to proceed in the direction denoted. 

If the red light appears drivers stop the vehicles otherwise go. Every 

signal on the road directs the vehicles in correct way. It is one of the 

selection examples.  

 

Selection is used to execute different statements depending on cretin condition. The following 

flowchart symbol is for the selection. 

 

 

 

 

 

 

Example 1: 

Go to school through highway road. 

Go to the road. 

See the signal 

If signal light is Green, go on the way 

Otherwise wait for some time. 

Condition Yes No 

Start 

Go to the road 

see signal light 

 

If signal light 

is  green ? 

 

Wait for some time 

 

Go on the way 

 

Stop 

No 

Yes 

Fig 4.1.1 Color lights 

Fig 4.1.2 Flow chart symbol for the selection 

Fig 4.1.3  Flowchart for the Example 1 

https://en.wikipedia.org/wiki/Right-of-way_(traffic)
https://www.google.com/url?sa=i&source=images&cd=&cad=rja&uact=8&ved=2ahUKEwipo62HzaLbAhWTT30KHVHFAawQjRx6BAgBEAU&url=http://getdrawings.com/traffic-lights-drawing&psig=AOvVaw1iwVWu5sNW4_GWC2UT2qM-&ust=1527397419985569
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Example 2: 

 

One of the real time problem for students is do homework. For many kids, homework is the biggest 

problem, which they usually leave to the very last minute to get done. First analysis How to solve 

this problem them shelf, then draw a flow chart of the solution of the problem.  

 Go to house. 

 Check, do you have homework. 

 If it no, laying or studying 

 Otherwise, start to do the homework. 

  

 

 

 

 

Example 3: 

If a given marks is greater than 50, 

displays “Pass” or “Fail” 

Get the Marks 

Check whether it is greater than 50 

If it Grater than 50 display “Pass” 

Otherwise display “Fail” 

 

 

 

Start 

Go to House 

 

Do you have 

homework? 

 

You can Play or study 

 

Do the homework 

first 

 

Stop 

No 

Yes 

Start 

Get marks 

 

Is 

Marks>50 

 

Stop 

No 

Yes 

“Pass” 

“Fail” 

Fig 4.1.4  Flowchart for the Example 2 

Fig 4.1.5   Flowchart for the Example 3 
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Example 4: 

If a given marks is greater than 50, Draw Green Line or Draw Red Line   

Get the Marks 

Check whether it is greater than 50 

If it Grater than 50 Draw Green Line 

Otherwise Draw Red Line 

 

 

  

Start 

Get marks 

 

Is 

Marks>50 

 

Stop 

No 

Yes 

Draw Red Line 

 

Draw Green Line 

 

Fig 4.1.6  Flowchart for the Example 4 
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Competency:  4 Uses flow chart to solve simple problems with sequence, selection and develop 

programs (Using Scratch) 

 

Competency Level: 4.2. Uses control structures to develop simple programs 

Time: 5 periods 

Learning Outcomes:  

 Describes control structures (selection only) 

 Applies control structures to solve simple day to day problems 

 

Content  

 Introduction to  simple algorithm and control structures of Selections 

 Developing simple programs (Sequence and Selection) using visual supports of 

programming language (using an Interface) 

 

Concepts and terms need to be highlighted:  

 Control Structure 

 Sequence 

 Selection 

 Algorithm 

 Scratch Program 

 Scratch Program selection  

 

Guidance for lesson plans:  

 Discuss how to face a problem with control structure (Selection). 

 Discuss Control structure( Sequence, Selection, Repetition) 

 Divide the class into groups  and give a scenario to Analysis 

 Ask the groups to do a Scratch program of the above scenario. 

 

Guidance for assessments and evaluations:  

 Assign each group for  the following activity  

o Write a suitable scenario for a selection control structure. 

o Solve the problem with algorithm 

o Draw the flowchart and do Scratch   

 

Quality inputs:  

Scratch program, Task sheet 

 https://scratch.mit.edu/download 

 https://www.youtube.com/watch?v=0aCYwtQFV0c 

 

https://scratch.mit.edu/download
https://www.youtube.com/watch?v=0aCYwtQFV0c
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  

Reading Material 

 Selection is a very important concept in programming. Using selection statements, we can 

get our programs to make decisions. Decision-making by a computer is based on the same two-step 

process. In scratch, decisions are made with the if blocks, and if else blocks. When processing an if 

statement, the computer first evaluates some criterion or condition. If it is met, the specified action 

is performed. Here are the blocks for the selection. 

 

 

 

 

Example 1: 

If a given marks is greater than 50, Draw Green Line or Draw Red Line. 

 

The above scenario is already analysis with flow chart.  The following blocks are design in scratch.  

 

 

Fig 4.2. 2 Block for the Example 1 

 

 

 

 

 

 

 

Out put  

 

Fig 4.2. 1 Blocks for the selection 

Fig 4.2.3   output for the Example 1 
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Example 2: 

If a given marks is greater than 50, displays “Pass” or “Fail. 

 

            Fig 4.2. 4 Block for the Example 2 

 

 

 

 Fig 4.2.4  output for the Example 2 

Example 3: 

If a given number is Odd, displays “Odd Number ”or display “Even Number”. 

 

 

 

 

 

 

 

 

Out put  

 

 

Out put  

 

 

 

Fig 4.2. 5 Block for the Example 3 

Fig 4.2.6 output for the Example 3 
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Competency:  5 Uses a software package for physical computing to implement programming logic 

 

Competency Level: 5.1.Uses a simple hardware device to implement physical computing 

Time: 5 periods  

Learning Outcomes:  

 Writes a program to operate external circuits using two logic levels (yes/no, on/off) 

 Implements programs on physical devices. (Example: Turning On/Off the LEDs with 

passing values) 

Content  

 Components of physical computing device 

 Controllable devices 

 Turning on/off LEDs 

 Design LED patterns with simple programs 

 

Concepts and terms need to be highlighted:  

 Observe different types of microcontroller circuit 

 Writes basic component of microcontroller circuit 

 Writes a program to operate external circuits using two logic levels (yes/no, on/off) 

 Implements programs on physical devices. Example: Turning On/Off the LEDs with passing 

values 

 

Guidance for lesson plans:  

  Collect information about different microcontroller circuit 

  Explain the Micro bit circuit and it’s components 

  Writes programs to display different texts and values with LED lights on and off 

 Display different value according to the pressing the button on the circuit  

 

Guidance for assessments and evaluations:  

 Write a code for Micro Bit circuit to display own name when a button pressed.  

 Write programs to display different values for different two button combinations 

Quality inputs:   

 Computer, Micro Bit circuit and USB connecting cable, downloaded software from the 

Internet  

 https://makecode.microbit.org/ 

 https://microbit.org/guide/ 

  https://www.youtube.com/watch?v=Wuza5WXiMkc 

 https://www.youtube.com/watch?v=cJRrTxgLRIc 

 

https://makecode.microbit.org/
https://microbit.org/guide/
https://www.youtube.com/watch?v=Wuza5WXiMkc
https://www.youtube.com/watch?v=cJRrTxgLRIc
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Reading Material 

Different types of micro controller circuits 

 Micro Bit circuit 

 

                                   Fig 5.1. 1   Micro Bit circuit 

Features 

• 25 individually-programmable LEDs 

• 2 programmable buttons 

• Physical connection pins 

• Light and temperature sensors 

• Motion sensors (accelerometer and compass) 

• Wireless Communication, via Radio and Bluetooth 

• USB interface 

 Arduino UNO Board 

 

                                               Fig 5.1. 2 Arduino UNO Board 
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Features 

 Microcontroller: ATmega328P 
 32 KB of Flash memory 

 Operating Voltage: 5V 

 Input Voltage (recommended): 7-12V 

 Input Voltage (limits): 6-20V 

 Digital I/O Pins: 14 (6 pins provide PWM output) 

 Analog Input Pins: 6 

 DC Current per I/O Pin: 40 mA 

 DC Current for 3.3V Pin: 50 mA. 

 

 Boards with Atmel Micro processors  

 

Fig 5.1.3 Boards with Atmel Micro processors  

 

Coding with Micro Bit microcontroller circuit 

Open the editor using the following web site to create coding for Micro Bit circuit. 

https://makecode.microbit.org/ 

When the MakeCode editor is open with the above address, make a desktop link dragging the 

address bar icon to the desktop. Then it will create a desktop icon. 

The next time you may not need to have Internet connection for the Micro Bit editor. Simply, you 

can open the editor by clicking on the desktop icon. 

The editor MakeCode is an HTML5 web application. It automatically caches locally in the hard 

disk when first viewed in your browser. After the web app has loaded you will have everything in 

your hard disk that you need to continue working without an Internet connection.  

You may have following screen with the editor. 

https://makecode.microbit.org/
https://makecode.microbit.org/
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                                                                        Fig 5.1.4 screen with the Micro Bit editor 

There are two modes in editor Blocks and JavaScript(). Do not select JavaScript(). It is difficult for 

beginners.  

The editor provides several control blocks. They have categories in to several groups as follows. 

Basic, Input, Music, Led, Radio, Loops, Logic, Variables and Math 

The following groups are available under the Advanced option. 

They are Functions, Arrays, Text, Game, Images, Pins, Serial and Control. 

Programming Micro Bit Circuit  

 

 

 

Fig 5.1. 4 Groups available under the Advanced option 
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There are several control blocks under each group. 

Control Blocks in the Basic category 

 

 

                                               Fig 5.1. 5 Control Blocks in the Basic category 

There are more blocks under “… more” button. They are displayed below. 

 

                                                               Fig 5.1. 6   Blocks under the “…more” button 
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Control Blocks in the Input category 

 

                                                  Fig 5.1. 7  Control Blocks in the Input category 

Similarly there are several control block under each category. 

Now let us create a program to programming the Micro Bit circuit. 

Example 01 

Let us display a text using the LED lights on the Micro Bit circuit. 

Select the “On Button A Press” control block under Input group and drag the block to the program 

area as shown below. 

                      Fig 

Fig 5.1. 8  After selecting and dragging the “On Button A Press” control block to the program area 
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If you click on A at “On Button A Pressed”, you will have more button options of B and A+B. 

Button A is in the left side of the LEDs and Button B is in right side of the LEDs. There A+B 

means both are pressed. 

For this example do not change the button, keep it as A. 

Then open the Basic group and select the “Show String” block. Drag the block to the middle of the 

earlier “On Button A Pressed” block to create the following program. 

 

           Fig 5.1. 9  After selecting and dragging the “Show String“ block to the middle of the “On Button A  Pressed” block. 
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Change the text on the “Show String” block to “ICT Grade 8”. Then the program is as follows. 

 

Fig 5.1. 10  After Changing the text on the “Show String” block to “ICT Grade 8”. 

This simple program is completed. The current name of the program is Untitled and you can rename 

the program as MyPro01 erasing “Untitled”. Click on Download button to save the hex file in the 

download folder of the computer. The hex file contents digital codes for the graphical 

representation of the program. Such hex file can upload to the Micro bit circuit. If you check your 

download folder, you may found new file called “microbit-MyPro01.hex”.  

 

Fig 5.1. 11  When the Micro Bit circuit plugs to the computer through the USB cable 

 

This hex file should upload to the Micro Bit circuit to run the program by the circuit. When the 

Micro Bit circuit plugs to the computer through the USB cable it shows a folder with two files in a 

new driver as follows. You may have different drive letter instead G: . 
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                  Fig 5.1. 12  Folders showing in a new driver, after plugging the Micro Bit circuit to the computer  

 

If you do not have this folder, unplug the circuit and plug it again. Copy your hex file to this folder. 

Then you will see LED on Micro Bit circuit is blinking speedily while uploading the hex file. 

Then turn the circuit to next side and finds two buttons. Click on the Button A. Then you will see 

running characters in the LED grid. It says your message “ICT Grade 8” 

Example 2: MyPro02 

Now modify above program as follows. Writes code to display your name when the button B is 

pressed. Name the program as MyPro02 

 

                                                                           Fig 5.1. 13  Blocks for the  Example 02 
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Example 03: MyPro03 

In this program another block of “on button pressed” is used. Here, A+B is selected for pressing 

both buttons at once. Select “show leds” in the Basic category and drag to the middle of the block 

of “on button A+B pressed”.  

 

                                                               Fig 5.1. 14   Blocks for the Example 03 

Upload the program and see the led pattern when both buttons are pressed. 

Example 04 Mypro04    

The following program has three blocks. This “on shake” blocks has selected from Input category. 

The option of “Shake” has changed in the next block with “Screen Up” and “Screen Down”.     
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                                                                           Fig 5.1. 15  Blocks for the Example 04 

After upload the program to the circuit shake the micro bit circuit and see the pattern of LEDs. Then 

up and down the circuit to see the different patterns. 

Example 5: MyPro05 

 

                                                  Fig 5.1. 16 Blocks for the Example 05 

Following two programs Forever block has used. It is available on the screen when you take a new 

project.  The block of “pause (ms) 100” is available in the Basic category. Here, pause value has 

changed to 10 milliseconds. 
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Example 06 : MyPro06 

 

 

                                                                        Fig 5.1. 17  Blocks for the Example 06 

 

Try to prepare your own patterns of LEDs lights with different time intervals. 
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Competency:  6 Explores educational information using the Internet 

 

Competency Level 6.1: Searches information on the Internet 

 

Time: 1 period 

 

Learning Outcomes:  

 Identifies Search Engines 

 Searches information using the Internet 

 

Content  

 Search Engines: Google, Yahoo etc. 

 Educational browsers 

 

Concepts and terms need to be highlighted:  

 Internet 

 Search Engines 

 Browsers 

 Educational browsers 

 Website  
 

Guidance for lesson plans:  

 Explain Basic of internet. 

 Divide the students in groups.  

 Provide instructions to search, in a search engine for a given tasks. 

 

 

Guidance for assessments and evaluations:  

 Children could be asked to use a search engine to research information for a new topic or 

project. They could note down how many results each search brings up. If they word the 

search term slightly differently, do different results come back? Discuss why this could 

happen 

 

Quality inputs:   

 Computer with internet connection 

 https://www.computerhope.com/issues/ch000082.htm 

 https://www.techopedia.com/definition/288/web-browser 

 

https://www.computerhope.com/issues/ch000082.htm
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Reading Material 

 

The internet 

The internet is made of computers connected to each other around the world. This is a global 

network connecting millions of computers. When you use websites and some apps, you are using 

the internet. 

Connecting to the internet  

To connect to the internet the following are needed: 

 A Computer 

 Modem/Telephone Connection, dongle, Wi-Fi Router 

 Internet Service Provider (ISP- Ex :- Dialog, Mobitel, Telecom) 

 Web browser(Ex :-Google Chrome, Safari, Opera, Internet Explorer, Firefox) 

 

  Or  

 Smart Phone with Internet connection  

 

 

What can you do on the internet?  

Of the many things available to do on the internet, you can:  

 browse websites 

 send and receive email 

 download media files, eg Mp3s or video files 

 watch streamed video, eg BBC iPlayer, YouTube etc 

 check your bank balance and make payments 

 buy goods from online shops 

 access educational material from your school’s Virtual Learning Environment (VLE) 

 create, store, edit and share your documents using web-based applications, eg Google Docs 

 interact with friends on social networking sites, egBebo, MySpace, Facebook etc 

 write a blog 

 sign-up to forums and discuss topics that interest you with like-minded individuals 

 game with friends 

 instant message family and friends 

 share photos and videos 

 complete free tutorials covering a wide range of subjects 

Search engines 

The internet is a useful tool that helps you to learn, to share, to communicate and to find 

entertainment. It has billions of pages filled with information, in the form of words, images, videos 

and sound. Finding the information you need from these billions of pages can be very difficult. If 
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you had to look through each page, it would take many years to find the information you seek. 

Search engines make the task much simpler. 

Search engines are programs that are designed to search the internet for us. They search through all 

the billions of webpages, looking for information that matches what you are seeking. By using a 

search engine you can find information in seconds. 

Eg: Google, Bing , Yahoo , Ask , AOL 

How search engines work 

When you use a search engine to find information, you type in a search term which consists of one 

or more keywords that are specific to the information you seek.  

The search engine would look through all the webpages on the internet and create a list of links (or 

results) to all pages that contain these keywords. The list is sorted into order, with the most popular 

(or most visited) results at the top. You can then choose to follow any of the listed links and 

websites to see what information they contain. 

Web browsers  

A web browser is software that allows us to see web pages. There are a number of different web 

browsers, such as: 

 Microsoft Edge (new version of Internet Explorer) 

 Mozilla Firefox 

 Google Chrome 

 Safari 

 Opera 

Some of the browsers listed above also have mobile versions.  

Hyperlinks 

A hyperlink is what we use to move around the web from page to page. A hyperlink is often 

underlined, though not always. Hyperlinks can be text, images, buttons, or moving images. 

1. World wide web (www) 

The world wide web (www) is a collection of multimedia web pages on the internet that can be 

displayed on any computer using a browser. 

It was invented in 1989 by Tim Berners-Lee while he was working at the European Organization 

for Nuclear Research - he wanted to find a method by which scientists could combine their 

knowledge and work collaboratively. 

2. Hyperlinks 

These allow the visitor to navigate a website by clicking on text or pictures to move from one page 

to another. They are usually shown by underlined blue text on the page. 
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3. Hypertext Markup Language (HTML) 

HTML is the computer language used to create web pages. 

4. Web page 

A web page is a single HTML file that contains text, images, audio and video. It is part of a website 

and has a unique name given to it. 

5. Search engine 

When using a search engine such as Google a simple search is when you type in a word or phrase 

to look for. For example, typing in Scotland will give you lots of 'hits' or results. 

6. Connecting to the internet 

There are two ways of connecting to the internet: dial-up and broadband. 

Dial-up uses an existing telephone line. The maximum connection speed of the modem is 56kbit. 

The cost is charged per minute. 

Broadband offers a much faster connection and has other advantages over dial-up: 

 always connected 

 faster downloads 

 multiple computers accessing the internet if connected to a LAN 

 can use the telephone at the same time as accessing the internet 

The user is said to be online if they are connected to the internet and offline when they are no 

longer connected to the internet. 

1. Internet service provider (ISP) 

An internet service provider (ISP) is a company that provides the connection to the internet. They 

can also provide email, web space and anti virus software for all their subscribers. 

1. Mobile internet technologies 

These are devices that allow you to work without access to a mains power supply, e.g. laptops, 

PDAs, mobile phones, etc. These devices get access to the internet via wifi or mobile phone 

networks. 

2. Video conferencing 

This allows two or more people, at different sites around the world, to communicate via a computer 

network, using audio and video. You would need a webcam or digital video camera, speaker, 

monitor, microphone and video conferencing software at both ends of the computer network. 
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Competency 6:  Explores educational information using the Internet  

 

Competency Level: 6.2 Creates websites with advanced features 

  

Time: 2 periods  

  

Learning Outcomes:  

 Designs websites as per specifications 

 Develops websites as per design 

 

Content  

 Tags, Elements, Attributes, Text formatting etc. 

 Advanced features in hyperlinks 

 

Concepts and terms need to be highlighted:  

 Tags 

 Elements 

 Attributes 

 links 

 Hyperlinks 
 

Guidance for lesson plans:  

 Explain Basic of HTML. 

 Divide the students in groups.  

 Provide instructions to develop a simple website. 

 

 Guidance for assessments and evaluations:  

 Write HTML Coding for the given context 

 Write output (layout) for the given HTML coding 

 

Quality inputs:   

 Computer 

 Collection of images to use in web pages 

 www.nie.lk web site 

 

 

 

 

http://www.nie.lk/
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Reading Material 

Basics of HTML 

 What is HTML? 

 HTML is the standard markup language for creating Web pages. 

 HTML stands for Hyper Text Markup Language 

 HTML describes the structure of Web pages using markup, HTML elements are 

represented by tags 

Eg: <b>I want to bold this</b>. 

</b> tells the web browser when to stop bolding. 

 

 Each HTML file is broken up into two parts 

o The head contains information about the website.  

o The body contains information about the content of your site. This is what you see when 

you go to a webpage. 

Introduce Basic HTML tags 

 Everything in an HTML file is enclosed by </html> and </html> 

 Use text editor to write HTML codings 

 Create a new HTML file by clicking on File then New in text editor. 

 Write your html code. 

 Save your new HTML file as follows 

 File –>  save as  –>   example1.html  –>   save 

 (here we must type .html extension to inform this is a web page written in html) 

 

• example 1 : Display without a tag 

<html> 

<body> 

type your name  

</body> 

</html> 

 

• example 2 : Use h1 tag. 

<html> 

<body> 

<h1>This is the heading 1</h1> 

</body> 

</html> 
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• example 3 : Display name on the web page as a heading 

<html> 

<body> 

<h1>type your name</h1> 

</body> 

</html> 

 

• example 4 : Show the different types of headings and compare them. 

<html> 

<body> 

<h1>This is the heading 1</h1> 

<h2>This is the heading 2</h2> 

<h3>This is the heading 3</h3> 

<h4>This is the heading 4</h4> 

<h5>This is the heading 5</h5> 

<h6>This is the heading 6</h6> 

</body> 

</html> 

 

 

 Create a new HTML file with the name example2.html 

 

 example 1 : Use paragraph tag. 

<html> 

<body> 

<p>this is a paragraph</p> 

</body> 

</html> 
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 example 2 : Insert multiple paragraphs and see it allows to enter multiple line paragraphs in 

a web page.  Browsers automatically add a blank line before and after a paragraph. 

<html> 

<body> 

<p> Current Scenario of Internet Everyone  is  looking  to  have  a  wonderful  

and  easy  to  use  website,  but it is not easily possible because a  perfect  

website  development  procedure is needed that makes your website creative 

from other websites. As we all know that a unique  website  is  able  to  

attract  lots  of  visitors  to  your website  and  help  you  to  turn  them  into  

potential customers. </p> 

 

<p> These  days,  we  can  say  that  a  website development  is  one  of  the  

most  demanding  tasks  as  it includes  designing,  developing,  search  

engine optimization, creation of content and many more aspects. </p> 

 

<p> Today in the world of Internet, it is must for every business person to 

have a website for his business because lots of people are looking to buy 

products or hire services online as they can save their precious time as well 

as money.</p> 

</body> 

</html> 
 

Insert text formatting to a Web page 

 Create a new HTML file with the name example3.html 

 

 example 1 : Use text formatting - bold. 

<html> 

<body> 

<p><b>this text is bold</b></ p> 

</body> 

</html> 

 example 2 : Use text formatting - underline. 

<html> 

<body> 

<p><i>this text is underlined</i></p> 

</body> 

</html> 
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 example 1 : Use text formatting - italic. 

<html> 

<body> 

<p><i>this text is italic</i></p> 

</body> 

</html> 

Use more text formatting to a Web page 

 Create a new HTML file with the name example4.html 

 example 1 :  Use <sub> element to define  subscripted  text. 

<html> 

<body> 

<p>Carbon dioxide  - CO <sub>2</sub>  is a colourless gas .</p> </body> 

</html> 

 

 example 2 :  Use <sup> element to define  superscripted  text. 

<html> 

<body> 

<p>2  <sup>3</sup>  means 8 in decimal.</p> 

</body> 

</html> 

HTML Elements 

An HTML element usually consists of a start tag and end tag, with the content inserted in between: 

Eg: The <body> element defines the document body. 

It has a start tag <body> and an end tag </body>. 

 

HTML Attributes 

All HTML elements can have attributes . Attributes provide additional information about an 

element. Attributes are always specified in the start tag.  
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Eg:  Attributes usually come in name/value pairs     

like: name="value" 

font color="red" 

 example 1 :  change font colour. 

<html> 

<body> 

<p><font color="red">Colour  changed</font></p> 

</body> 

</html> 

 

 example 2 :  Change font size. 

</html> 

<body> 

<p><font size="3" > Size of the font changed ! </font></p> 

</body> 

 </html> 

 

 example 3 :  Change the font type. 

</html> 

<body> 

<p<font face="verdana">font type changed</font></p> 

</body> 

</html> 

 

 example 4 :  Change font attributes. 

<html> 

<body> 

<font size="5"  face=" Monotype Corsiva"  color="green"> Different text!</font> 

</body> 

</html> 

 

Make a link using HTML 

The <a> tag defines a hyperlink, which is used to link from one page to another. 

 href attribute of the <a> element indicates the link's destination. 

 By default, links will appear as follows in all browsers: 

 An unvisited link is underlined and blue 

 A visited link is underlined and purple 

 An active link is underlined and red 
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<html> 

<body> 

<p>  

This is a link to <a href="http://www.nie.lk/"> NIE- Sri Lanka </a>. 

</p> 

</body> 

</html> 

 

The target Attribute 

The target attribute specifies where to open the linked page. 

The target attribute can have one of the following values: 

 _blank - Opens the linked document in a new window or tab 

 _self - Opens the linked document in the same window/tab as it was clicked (this is default) 

 _parent - Opens the linked document in the parent frame 

 _top - Opens the linked document in the full body of the window 

This example will open the linked document in a new browser window/tab: 

Eg: 

<html> 

<body> 

<p>  

This is a link to <a href=http://www.nie.lk/ target="_blank"> NIE- Sri Lanka </a>. 

</p> 

</body> 

</html> 

 

Link Titles 

The title attribute specifies extra information about an element. The information is most often shown as a 

tooltip text when the mouse moves over the element. 

<html> 

<body> 

<p>  

This is a link to <a href=http://www.nie.lk/ title="Visit National Institute of Education 

– Sri Lanka "> NIE- Sri Lanka</a>. 

</p> 

</body> 

</html> 
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Image as Link 

In this example the image Uses as a link which is in the same folder 

<html> 

<body> 

 

<a href="html_images.asp">HTML Images</a> 

 

</body> 

</html> 

 

 

 

Two pages located in the same folder 

Make two web pages namely page1.html and page2.html with the following code lines  

 

Page 1 

<html> 

<body> 

<h1>Welcome to page 1 !</h1> 

<p>Hello. Do you want to view <a href="page2.html">page 2</a> ?</p> 

</body> 

</html> 

 

Page2 

<html> 

<body> 

<h1>Welcome to page 2 !</h1> 

<p>Hello. Do you want to view <a href="page1.html">page 1</a> ?</p> 

</body> 

</html> 

 

 

 

 


